Data Migration of Non-SAP Systems to SAP-Systems

Quick Introduction to Working with the Legacy System Migration Workbench
Version 3.0

August 28, 2002
Table of Contents

1 INTRODUCTION ........................................................................................................................................... 4
  1.1 PURPOSE OF THIS INTRODUCTION ................................................................................................. 4
  1.2 LSM WORKBENCH: WHAT IS IT? .................................................................................................... 4
  1.3 SUPPORTED RELEASES ................................................................................................................ 4
  1.4 COSTS ............................................................................................................................................... 4
  1.5 DELIVERY ....................................................................................................................................... 4
  1.6 LSM WORKBENCH VERSIONS ...................................................................................................... 4
  1.7 SUPPORT ...................................................................................................................................... 5
  1.8 SIGNIFICANCE OF DATA MIGRATION .......................................................................................... 5
  1.9 BASIC PRINCIPLES OF THE LSM WORKBENCH ........................................................................ 5

2 STARTUP AND PREPARATIONS .................................................................................................................. 7
  2.1 AUTHORIZATIONS .......................................................................................................................... 7
  2.2 INITIAL TRANSACTION ................................................................................................................ 7
  2.3 PROJECT, SUBPROJECT AND OBJECT .......................................................................................... 8
  2.4 USER GUIDANCE ........................................................................................................................... 9
  2.5 FIELD MAPPING ON PAPER ......................................................................................................... 10
  2.6 CREATE OBJECT OVERVIEW ........................................................................................................ 10
  2.7 ADMINISTRATION ........................................................................................................................ 14
  2.8 RECORDINGS ................................................................................................................................ 14
  2.9 PREPARATIONS FOR USING IDOC INBOUND PROCESSING .......................................................... 15

3 GENERAL TIPS FOR A MIGRATION USING LSMW AND DX-WORKBENCH ........................................ 19
  3.1 CUSTOMIZING .............................................................................................................................. 20
  3.2 WHICH DATA SHOULD BE MIGRATED? .......................................................................................... 20
  3.3 RUN THE MANUAL PROCESS ....................................................................................................... 20
  3.4 WHICH IMPORT TECHNIQUE WILL BE USED? .......................................................................... 20
  3.5 CREATE THE RECORDING ............................................................................................................ 20
  3.6 FILL OBJECT ATTRIBUTES .......................................................................................................... 21
  3.7 DETERMINE THE SOURCE STRUCTURES .................................................................................... 21
  3.8 CREATE TEST DATA IN DX-WORKBENCH .................................................................................... 21
  3.9 MAPPING ON PAPER .................................................................................................................... 21
  3.10 MAINTAIN STRUCTURE RELATIONS ........................................................................................... 21
  3.11 DATA EXPORT ............................................................................................................................ 21
  3.12 ENTER THE RULES AND TEST OUT OF LSMW ....................................................................... 22
  3.13 CREATE PROJECT, SUBPROJECT AND RUN IN DX-WORKBENCH .............................................. 22
  3.14 IMPORT THE DATA ...................................................................................................................... 22

4 DATA MIGRATION – STEP BY STEP ........................................................................................................ 23
  4.1 MAINTAIN OBJECT ATTRIBUTES ............................................................................................ 23
  4.2 MAINTAIN SOURCE STRUCTURES ............................................................................................ 24
  4.3 MAINTAIN SOURCE FIELDS ....................................................................................................... 26
    4.3.1 Create Individual Source Fields .......................................................................................... 26
    4.3.2 Maintain Source Fields in Table Form ............................................................................. 28
    4.3.3 Copy Source Fields from Other Sources ........................................................................ 29
  4.4 MAINTAIN STRUCTURAL RELATIONSHIPS ............................................................................... 30
  4.5 MAINTAIN FIELD MAPPING AND CONVERSION RULES ........................................................ 32
    4.5.1 For the Advanced User: Display Variant, Processing Times ............................................. 35
    4.5.2 For the Advanced User: Global Variables ....................................................................... 37
    4.5.3 For the Advanced User: Global Functions ...................................................................... 38
    4.5.4 For the Advanced User: Reusable Rules — Naming Conventions .................................. 39
  4.6 MAINTAIN FIXED VALUES, TRANSLATIONS AND USER-WRITTEN ROUTINES .......................... 40
  4.7 SPECIFY FILES .......................................................................................................................... 43
  4.8 USE WILDCARDS IN FILE NAMES ............................................................................................ 48
  4.9 ASSIGN FILES ........................................................................................................................... 50
  4.10 READ DATA .............................................................................................................................. 50
    4.10.1 Display Read Data ............................................................................................................. 51
1 Introduction

1.1 Purpose of this Introduction

This introduction is intended to allow a quick entry into the work with the Legacy System Migration Workbench Version 3.0 (“LSM Workbench”).

1.2 LSM Workbench: What is it?

The LSM Workbench is an SAP-based tool that supports You when transferring data from non-SAP systems (“Legacy Systems”) to SAP systems once or periodically.

The tool supports conversion of data of the legacy system in a convenient way. The data can then be imported into the SAP system via batch input, direct input, BAPIs or IDocs.

Furthermore, the LSM Workbench provides a recording function that allows to generate a “data migration object” in an entry or change transaction.

1.3 Supported Releases

Version 3.0 (this version) of the LSM Workbench can be used in SAP systems with maintenance level ‘Web Application Server’ (6.10).

For maintenance levels 3.1x please use version 1.0 of the LSM Workbench, for maintenance levels 4.0x, 4.5x and 4.6x please use version 1.7 of the LSM Workbench.

1.4 Costs

SAP makes this tool available to their customers and partners free of charge.

1.5 Delivery

At the moment the LSM Workbench is not part of the standard SAP system. If you are interested in this product, please contact SAP via:

- SAPNet (Online Service System): component BC-SRV-DX-LSM or
- SAPNet: http://service.sap.com/lsmw

There you find all available information and documentation and the software itself (transport file). Among others, the following accompanying material is available:

- Check list for the usage of the LSM Workbench
- Presentation of the LSM Workbench (PowerPoint presentation)
- Quick introduction guide

1.6 LSM Workbench Versions

Version 1.0 of the LSM Workbench was made available to about 350 interested customers and partners in the frame of the First Customer Shipment between March 1998 (CeBIT) and middle of August 1998. The resulting experiences and feedback were taken into account in the further development.

---

1 SAP-System includes SAP-R/3, APO 2.0 and CRM 3.0; LSMW has its own namespace and there are no problems known with the industry solutions yet
In August 1998, version 1.0 of the LSM Workbench was made available to the public. Until today, LSMW has been requested more than 1,000 times.

In June 1999, version 1.5 of the LSM Workbench has been released.

Since July 1999, version 1.6, since September 2000 version 1.7 of the LSM Workbench has been available.

The actual version 3.0 is available since November 2001.

1.7 Support

For problem messages via SAPNet (Online Service System), entry "BC-SRV-DX-LSM" is available in the component hierarchy. When you enter a message, please specify the number of the LSM Workbench version you are using. (To display the version number, select Extras → Display LSMW version in the initial screen of transaction LSMW.)

Note: If problems occur after step Convert data, please directly contact the special department responsible for the module (FI, CO, MM, SD, HR, etc.). All steps following the data conversion are not LSM Workbench functions. Therefore the LSMW team cannot provide support for these functions.

1.8 Significance of Data Migration

Data migration comes in the end of SAP implementation. At this time, the SAP system is normally installed and application customizing is finished (in the best case).

An examination of SAP implementation projects by SAP Consulting has shown that data migration is about 20% of the total implementation expenses. This portion may rise up to 40% in smaller implementation projects.

A significant reduction of the expenses for data migration results in a corresponding significant reduction of the total project budget and the project runtime.

The experiences with the LSM Workbench in SAP implementation projects are very promising: Both the expenses and the costs of data migration could be reduced significantly.

1.9 Basic Principles of the LSM Workbench

The LSM Workbench was developed on the basis of the R/2-R/3 Migration Workbench that has been used many hundred times in the past and is still used presently.

The following concepts and techniques from the R/2-R/3 Migration Workbench were adopted:

- Business objects instead of individual tables or field contents are migrated.
- The conversion rules to be defined are flexible and can be customized in the frame of migration customizing to meet the actual situation in the project in the user system.
- Preprogrammed conversion programs are not delivered. These programs are rather generated on the basis of the defined rules.

The LSM Workbench was developed on the basis of the following principles:
Legacy System Migration Workbench

- Most of the functions should reside in the SAP system. No collection of individual programs on different platforms.
- The quality and consistence of the data imported into the SAP system should be more important than speed and performance of data migration.
- Existing knowledge and coding should be used.
- The developed "mapping" and rules should be reusable and thus be used repeatedly in projects.

On this basis, a concept was developed that is represented in the following chart:

**Schematic Flow of Data Migration with the LSM Workbench**

The main advantages of the **LSM Workbench**:

- Part of the SAP system and thus independent of individual platforms
- A variety of technical possibilities of data conversion:
  - Data consistency due to standard import techniques:
    - Batch input
    - Direct input
    - BAPIs (Business Application Programming Interfaces)
    - IDocs (Intermediate Documents)
  The import technique to be used in an individual case depends on the business object.
- Generation of the conversion program on the basis of defined rules
- Clear interactive process guide
- Interface for data on frontend and application server
- Creation of data migration objects on the basis of recorded transactions
- Free of charge for SAP customers and SAP partners
2 Startup and Preparations

2.1 Authorizations

<table>
<thead>
<tr>
<th>Authorization level</th>
<th>Profile</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>B_LSMW_SHOW</td>
<td>The user can display all projects he has the authorization for and their work steps. He/she cannot switch to change mode.</td>
</tr>
<tr>
<td>Execute</td>
<td>B_LSMW_EXEC</td>
<td>The user can display data, and read, convert and import data.</td>
</tr>
<tr>
<td>Change</td>
<td>B_LSMW_CHG</td>
<td>The user has &quot;Execute&quot; authorization, and can change and copy objects.</td>
</tr>
<tr>
<td>Administrate</td>
<td>B_LSMW_ALL</td>
<td>The user can use all functions made available by the tool.</td>
</tr>
</tbody>
</table>

Please note: The profiles listed above are not included in the profiles of the standard SAP system, but are added to the installation client of the SAP system during the installation of LSMW. Step 2 of the installation procedure (client cascade) distributes the profiles to the clients of the SAP system. Therefore you have to adopt them (enter the project names) or create new profiles and add the required profiles to your user master record.

2.2 Initial Transaction

To start working with the LSM Workbench, use transaction LSMW:

---

**LSM Workbench – Initial Screen**
2.3 Project, Subproject and Object

On the initial screen, you can create a new project, corresponding subprojects and objects via *Edit* -> *Create new entry*.

- **Project**: An ID with a maximum of 10 characters to name your data transfer project. If you want to transfer data from several legacy systems, you may create a project e.g. for every legacy system.
- **Subproject**: An ID with a maximum of 10 characters that is used as further structuring attribute.
- **Object**: An ID with a maximum of 10 characters to name the business object.

In the initial screen, *All objects* provides a list of all projects created already. *My objects* displays a list of all objects you created personally. *All objects of the project* displays all objects of the selected project as tree structure. *Project documentation* displays any documentation written for the individual popups and processing steps. You can print the project documentation out, send it and save it in various file formats.

Select *Documentation* to enter your notes. After clicking, a popup is displayed in which you can write down your personal documentation. The documentation function is additionally available under *Administration* and *Recordings* in the first seven steps of data migration.

Below, you find an example for a project with several subprojects and objects. This representation is displayed by pushing the button *All objects of the project*:

![Example for a Project Structure](image-url)
2.4 User Guidance

After selecting an object, ENTER or CONTINUE leads you to the interactive process guide. Here you are guided through the individual steps of data migration.

This popup provides the following functions:

- **Execute**: Executed the selected processing step.
- **Personal menu**: Here you can make an individual selection from the displayed processing steps. Pressing button "Main steps" automatically activates all processing steps mandatory for a data conversion.
- **Numbers On or Off**: you can activate or deactivate the numbering of the individual processing steps.
- **Double click = Display or Double click = Change**: Here, you can determine whether display mode or change mode is selected by double clicking.
- **Object overview**: Displays all information on the selected object.
- **Action log**: Displays a detailed overview (date, user name, time) for all processing steps already carried out. You can reset the action log via Extras → Reset action log. This action is stored with a reference to the user and the date.
2.5 Field Mapping on Paper

Before you start working with the LSM Workbench, you should first map the required object on paper. To do this, create and print out the "object overview".

At this time, the overview only displays the list and description of the SAP structures and their fields. You may use it as a guideline for assigning the corresponding structures and fields of the source system to these target structures and target fields.

You can also download the overview in table form and fill the table in Excel to have the mapping as a file on your PC.

2.6 Create Object Overview

This function is available as pushbutton in order to enable you to create an object overview at any time:
Object Overview in list form: General Data, Structures, Structure Relations

Object Overview: Source Structures / Target Structures
### LSM Workbench: Object Overview (List)

#### Struct.: EKNH

EKNH-STYPE
- Rule type: Default settings
  - EKNH-STYPE = '1'.

EKNH-TCODE
- Rule type: Constant
  - EKNH-TCODE = '001'.

EKNH-KUNNR
  - Constant
  - EKNH-KUNNR = 'XX'.

EKNH-WHRS
- Rule type: Constant
  - EKNH-WHRS = '1'.

EKNH-EDITOR
- Rule type: Constant
  - EKNH-EDITOR = 'ED'.

### LSM Workbench: Object Overview (Table)

#### Target Field

<table>
<thead>
<tr>
<th>Field name</th>
<th>Field description</th>
<th>Type</th>
<th>Length</th>
<th>Source fields</th>
<th>Length Conversion Method</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPROD</td>
<td>Batch input structure for session data</td>
<td>CHAR</td>
<td>801</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAME</td>
<td>Batch group name</td>
<td>CHAR</td>
<td>812</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RENAME</td>
<td>Queue user ID / for historical reasons</td>
<td>CHAR</td>
<td>812</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STAT</td>
<td>Queue start date</td>
<td>DATE</td>
<td>810</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KHEDEP</td>
<td>Indicator: Hold batch input screens after processing ?</td>
<td>CHAR</td>
<td>801</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOBATA</td>
<td>No batch input exists for this field.</td>
<td>CHAR</td>
<td>801</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### BINKH

- Rule type: Batch input structure for session data
- Type Length: CHAR 801

#### BINKH - Customer Master Record Transaction Data for Batch Input

<table>
<thead>
<tr>
<th>Field name</th>
<th>Field description</th>
<th>Type</th>
<th>Length</th>
<th>Source fields</th>
<th>Length Conversion Method</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPBYRE</td>
<td>Customer master record type</td>
<td>CHAR</td>
<td>801</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TCODE</td>
<td>Transaction code</td>
<td>CHAR</td>
<td>820</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>KUNNR</td>
<td>Customer number</td>
<td>CHAR</td>
<td>810</td>
<td>CUSTOMER_HEADER-CUST 004</td>
<td>Prefix</td>
<td>codes</td>
</tr>
</tbody>
</table>

#### BINKH - Company code
  - Type Length: CHAR 804

#### BINKH - Sales organization
  - Type Length: CHAR 804

#### BINKH - Distribution channel
  - Type Length: CHAR 802

#### BINKH - Division
  - Type Length: CHAR 802

#### BINKH - Customer account group
  - Type Length: CHAR 804

#### BINKH - Credit control area
  - Type Length: CHAR 804

#### BINKH - General Customer Master Record Part 1 (Batch Input)

<table>
<thead>
<tr>
<th>Field name</th>
<th>Field description</th>
<th>Type</th>
<th>Length</th>
<th>Source fields</th>
<th>Length Conversion Method</th>
<th>Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPBYRE</td>
<td>Customer master record type</td>
<td>CHAR</td>
<td>801</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Note: you may use this before the development of field mapping and rules to print out the SAP structures for an object including the record description in order to carry out "mapping on paper".

Overview of Reusable Rules

SAP Coding

* Begin Routine
  for UR_FSTLZ
  using _in
  changing _out
  withexit code 999  p_in into p_out
  endfor
2.7 Administration

In the initial screen, you can display the administration functions via \textit{Goto} \rightarrow \textit{Administration}. Here you can find a list of all existing projects.

It enables you to create, process, display, delete, copy or rename projects, subprojects, objects and reusable rules.

By double-clicking on an entry you can branch to the entry display.

By positioning the cursor on an entry, you can store a personal note via \textit{Documentation}. For every processing action, the name of the person who made the last change and the date of the last change are stored.

2.8 Recordings

In the initial screen, you can display the recording functions via \textit{Goto} \rightarrow \textit{Recordings}.

If neither a standard batch input program nor a standard direct input program nor an IDoc is available for a data object, you can create a new object using the recording function of the \textit{LSM Workbench}. However, also in cases where a standard program is available, it may make sense to use the recording function in order to reduce the number of target fields.
Note: The recording function records a fixed screen sequence. It cannot be used for migrating data containing a variable number of items or for transactions with dynamic screen sequences!

Tip: It is possible to create a recording via SHDB, generate a program out of this recording, adopt the program to your needs and register the program to be able to use it in LSMW.

Use the documentation function: Make sure that you are working in change mode. Position the cursor on an entry and select Documentation. A popup is displayed where you can write down your own notes.

For a detailed description of the recording function see section 6.

2.9 Preparations for Using IDoc Inbound Processing

IDocs (Intermediate Documents) were developed for exchanging messages between different systems (SAP ⇔ SAP; R/3 ⇔ R/2; SAP ⇔ non-SAP system).

Since it is a standard interface to the SAP applications, this technique can also be used for transferring data.

To do this, however, some presettings and preparations are required (settings have to be done for each project). For a summary of these requirements see Settings → IDoc inbound processing in the LSM Workbench.
Legacy System Migration Workbench

The first requirement is a file port for the file transfer. If required, create a port of the file type via Maintain ports. To do this, position the cursor on "File" and press Create. You should be in change mode. SAP recommends:

<table>
<thead>
<tr>
<th>Port</th>
<th>LSMW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>Legacy System Migration Workbench</td>
</tr>
<tr>
<td>Version:</td>
<td>3 (IDoc record types SAP Release 4.x)</td>
</tr>
<tr>
<td>Outbound file</td>
<td>Please enter a (dummy) physical directory and a file name, i.e. 'filelsmw'</td>
</tr>
</tbody>
</table>

As an addition, you can specify a tRFC port. This port is required, if you do not want to create a file during data conversion but submit the data in packages directly to function module IDoc_Inbound_Asyncronous. SAP recommends:

<table>
<thead>
<tr>
<th>Port:</th>
<th>assigned by the system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version:</td>
<td>3 (IDoc record types SAP Release 4.x)</td>
</tr>
<tr>
<td>RFC destination:</td>
<td>Name of the SAP System</td>
</tr>
<tr>
<td>Name of port:</td>
<td>Legacy System Migration Workbench</td>
</tr>
</tbody>
</table>

Then the partner type should be defined or selected. SAP recommends:

<table>
<thead>
<tr>
<th>Partner type:</th>
<th>&quot;US&quot; (User)</th>
</tr>
</thead>
</table>

As of release 4.5A, this partner type is available in the standard system. Up to release 4.0B inclusive, this partner type is not available in the standard program and should be added. SAP recommends:

<table>
<thead>
<tr>
<th>Partner type:</th>
<th>Create US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report name:</td>
<td>/SAPDMC/SAP_LSMW_PARTNERTYPES</td>
</tr>
<tr>
<td>Form routine:</td>
<td>READ_USER</td>
</tr>
</tbody>
</table>
Short description: any

- Finally a partner number should be defined or selected. SAP recommends:
  
<table>
<thead>
<tr>
<th>Partner number:</th>
<th>LSMW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner type:</td>
<td>US</td>
</tr>
<tr>
<td>Partner status:</td>
<td>A (active)</td>
</tr>
<tr>
<td>Type:</td>
<td>US</td>
</tr>
<tr>
<td>Language:</td>
<td>DE or EN</td>
</tr>
<tr>
<td>Person in charge:</td>
<td>Your user ID</td>
</tr>
</tbody>
</table>

  - **Activate IDoc inbound processing**
    — Confirm with "Yes" (to be done once for each system)

  - **Verify workflow customizing** (to be done once for each system)
    — The following entries of the workflow runtime system should be marked with a green check mark:
      - Workflow Administrator maintained
      - Workflow RFC destination completely configured
      - Generic decision task classified completely
      - Sending to objects and to HR objects is active
To do this, you can start automatic customizing. After this you should set item "Monitoring job for work items with errors" to "not scheduled". (This means that you unmark the ID "Monitoring of WIs with temporary errors"). If you do not do this, the SAP system tries over and over again to post incorrect IDocs created during data migration.

Check the function with Test RFC destination. The following message should be displayed: 'Ping' executed successfully. The RFC destination for the SAP Business Workflow is fully configured.
3 General Tips for a migration using LSMW and DX-Workbench

The LSM Workbench / DX-Workbench is a tool that supports the transfer of data from non-SAP systems to SAP.

Core functions of the LSM Workbench:
1. Import data from a legacy system
2. Converting data from its original (legacy system) format to the target (SAP) format
3. Importing the data using the standard interfaces of SAP (IDoc inbound processing, batch input, direct input)

Core functions of the DX Workbench:
1. Data import
2. Monitoring for data import
3. Create and edit test data
4. Restart functionality

Recommendation
- For batch input / direct input: use the test functionality in DX-Workbench and run the whole import process from LSMW
- For BAPI / IDoc: use DX-workbench and do mapping and conversion via an LSMW object – LSMW can be called from DX-workbench as a task (from 4.6C on)

Before using the LSM Workbench or DX Workbench, you need a concept for data migration.
3.1 Customizing

- Make sure that the **Customizing** of your SAP system is finished.
  - The "ideal project":
    - First finish customizing
    - Then, run data migration

3.2 Which data should be migrated?

Analyze the data existing in the legacy system to determine which data will be needed in the future (also from a business-operational point of view).

3.3 Run the manual process

- Identify the transaction(s) in the SAP system you want to use for bringing the data into the SAP System. Here, it may also be relevant whether the data is required for statistical (evaluation) purposes or for further processing in the system.
- Test the relevant transaction in the SAP system manually with test data from the old system and make sure that all required fields are filled. There may be required fields that do not correspond to any data window in the legacy system. In such a case, assigning a fixed value or defining the field as optional for data transfer may be appropriate.
- Get acquainted with the terminology of the relevant data object.
  - E.g. XD01: Create customer master (see also the F1 help)

3.4 Which import technique will be used?

- Check the interfaces provided by the application. Is there a batch input program and an IDoc (for example)? You might have a look at the program library in the DX-Workbench at this point. Which method should be used in your project?
- In case of very small data quantities, it may be easier to carry out the transfer manually.
- With very large data volumes, however, batch input technology may lead to excessively long runtimes. Rough estimate for the required time: 10000 records per hour; this value, however, may vary strongly depending on the hardware.
- Batch input session are 'easy' in postprocessing
- Is a recording needed? Decide whether you want to use an existing import program (batch input, direct input, BAPIs, IDocs) or a recording:
  - Advantages of standard migration objects:
    - Includes screen sequences that may vary (e.g. with different material types)
  - Advantages of recordings:
    - Smaller number of target fields
    - Available for almost every transaction

3.5 Create the recording

- If you use a recording: Record the transaction and process the recording.
  - Specify
    - Field names
    - Field description
    - Default values
• If necessary:
  - Create the recording via transaction SHDB
  - Generate the program
  - Adopt the program to your needs
  - Registrate the program in DX-Workbench

3.6 Fill object attributes

Fill the object attributes in LSM Workbench according to the import technique chosen.

3.7 Determine the source structures

• Determine the source structures and fields
• Is the export done into multiple files or into on sequential file?
• Note: LSMW or DX-Workbench do not do exports from legacy systems
• Define the record structures of the legacy data and introduce them to the SAP system.
  — Case 1: Data is available in one or more files.
    ▪ Introduce these structures to the SAP system.
  — Case 2: Data (still) resides in the legacy system and the legacy system provides a function for exporting the data.
    ▪ Introduce this (these) record structure(s) to the SAP system.
  — Case 3: Data (still) resides in the legacy system and the legacy system does not provide a function for exporting the data.
    ▪ Define the record structure of the data you need.
    ▪ Export this data by means of a program to be written in the legacy system.
    ▪ Introduce this (these) record structure(s) to the SAP system.

3.8 Create test data in DX-Workbench

Via ‘Goto -> DX Tools’ you get to a transaction where an example import file can be created to test the import. This file can be filled manually for test purposes. For most of the business objects you have the possibility to create a test file out of data already posted in the SAP system.

3.9 Mapping on paper

• Develop a mapping plan in written form: Assign the legacy system fields to the SAP fields. A printed object overview from LSMW might help at this point.
• Determine the form (e.g. via „MOVE“ or assigned according to a rule) in which the legacy system data shall be transferred to the SAP System.
• If applicable, define the allocation rules (LSM-internal name: „translation rules“).

3.10 Maintain structure relations

Maintain structure relations in LSM Workbench.

3.11 Data export

• In which way will the data be extracted from the non-SAP system? Note: The LSMW does not extract data.
• If only a part of your legacy system will be replaced by SAP, determine which function will be provided by the SAP system and which by the legacy system. If applicable, set up a concept of data flows and interface architecture.

3.12 Enter the rules and test out of LSMW

Enter the rules and test steps reading and converting out of LSMW

• Read data – automatically by pushing a button

• Convert data
  — The left column of the translation table is filled automatically, if this was set accordingly in translation control.
  — A sequential file is created.

• Maintain the reusable rules:
  — Maintain the translation tables (F4 help for right-hand column).
  — Specify your fixed values.

• Maintain the translation tables and generate a new conversion. Please note: at this point the processing steps are not sequential.

3.13 Create project, subproject and run in DX-Workbench

Create project, subproject and run definition in the DX-Workbench und define the tasks, for example:
1. task: mapping and converting
2. task: import

For task mapping and converting the migration object created in LSMW can be called; the import is done with the output file of LSMW (xxx.lsmw.conv)

3.14 Import the data

Start the run in DX workbench

Depending on the object type:
— Batch input / recording:
  • Batch input session is generated
  • Run batch input session via SM35
— Direct input
  • Direct input session is started.
— IDocs / BAPI:
  • Converted data is transferred to IDoc inbound processing.
  • Check inbound processing!!
4 Data Migration – Step by Step

If you want to create or change objects, make sure that you are working in change mode. To activate this mode, click Change in the corresponding processing step. Only this mode provides all functions required for changing.

4.1 Maintain Object Attributes

In this step, object type and import technique are selected.

- Name your object. By entering data into field Owner, add the project to the list of all projects you created. You can display it afterwards in the initial screen under My objects.
Choose whether data transfer is one-time or periodic. In the case of periodic transfer, files cannot be read from the frontend. This adds processing step Frame program for the periodic data transfer.

Flag whether the file names are system dependant (this gives you the chance to later on enter file names per system id)

Select the object type and import technique. Here, an F4 help is available for the input field. This help displays the relevant lists from which you can select the objects.

- In the case of batch input and direct input, a documentation is available for the program under Program name (see symbol glasses).
- If you want to carry out batch input recording, you can enter further recordings by clicking the arrow.

Additionally you can use button 'Display available interfaces' to show the interfaces registered for a business object

Caution

If you apply import technique BAPI or IDoc, the program checks during the save operation whether a so-called partner agreement is already available for the preset partner (see section 2.9) and the selected message type. If this is not the case, the system tries to create them (see also section 4.13.3).

Note: Concerning flag "enable structure relation for EDIDC40" please have a look at chapter Error! Reference source not found.

4.2 Maintain Source Structures

In this step you define the structures of the object with name, description and the hierarchical relationships:

In the popup, click Change. You can now define, change, relink or remove structures. All these functions are available via pushbuttons.

When you define more than one structure, a popup is displayed querying the relations between the structures: same level/subordinated?
For migration objects created via transaction recording, you may only define one structure per recording here, since only one flat target structure per recording is available.

**Maintain Source Structures**

In the above example, one or several (or no) item records CUSTOMER_CONTACTS may exist for each header record CUSTOMER_HEADER.

Here, it is not determined yet whether these records are stored in one file or in two files.
4.3 Maintain Source Fields

In this section, fields are created and maintained for the structures defined in the preceding step.

There are several possibilities of defining and maintaining the source fields.

4.3.1 Create Individual Source Fields

Make sure that you are in change mode and the cursor is positioned on a source structure or an existing source field. Clicking on Create field displays the following popup:
You can select the field type from an underlying list with field type categories and the corresponding field description:

**Source Fields: Possible Field Types**
During data read, you can specify whether date values are converted into the internal date format (YYYYMMDD) and amount fields are converted into the calculation format (1234.56, i.e. no triad separators, decimal point).

If data for several structures is stored in one file the field **Identifying field value** has to be maintained.

Please maintain only one identifying field value per structure!

For fields of top hierarchy level structures, ID "selection parameter" can be set during Read/Convert data. If you set this indicator, the corresponding field is made available as selection parameter when reading or converting data. As a rule, this is used for testing.

### 4.3.2 Maintain Source Fields in Table Form

Make sure that you are in change mode and the cursor is positioned on a source structure or an existing source field. Clicking on **Table Maintenance** displays the following screen:

When you enter a field name and press **Enter**, the following values are proposed:
Legacy System Migration Workbench

- Field type 'C'
- Field length 10
- Field text = field name

4.3.3 Copy Source Fields from Other Sources

Make sure that you are in change mode and the cursor is positioned on a source structure or an existing source field. Selecting Copy Source Fields displays the following popup:

*Copy Source Fields: Selecting the Source*

**Upload (text separated by tabs):**

It is assumed that the source field description is stored in a text file the columns of which are separated by tabs, e.g.:

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Copy from another object</th>
<th>Source fields may be copied from the source structure of another object.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zip code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Street</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fax</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VAT number</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Copy from data repository:**
Source fields may be copied from a structure of the SAP Data Dictionary.

**From data file (field names in 1st line)**

Source fields may be copied from a data file. This file must be stored on the PC in the form of "text separated by tabs" and contain the field names in the first line.

![Example of a data file](image)

### 4.4 Maintain Structural Relationships

The structural relationships define the relationships between source and target structures.

The possible target structures are defined during the selection of the object type and the import technique.

In general, there are target structures that must be selected (required segments). In this case the following note is displayed: "This structure must be selected".

To define structural relationships, position the cursor on a field of the SAP structures / target structures. Clicking *Relationship* opens a window that displays the existing source structures for selection.

If you want to change the relation, remove the existing relation first. To do this, a pushbutton is available as well.

In addition, you can use *Check* to check the structural relationships for errors. The status bar then displays an error message or message: "The structural relationships do not contain any errors".
Maintain Structural Relationships

In the above example, the fields of SAP structures BGR00, BKN00, BKNA1, and BKNB1 are filled by the fields from CUSTOMER_HEADER, the fields of SAP structure BKNVK are filled by the fields from CUSTOMER_CONTACTS.

**Note 1**: Many Batch Input and Direct Input programs use a control record named BGR00 or BI000. You should always assign the top level source structure ("header structure") to this control record.

**Note 2**: It might be necessary to assign two or more source structures to one target structure. In this case you should proceed as follows: Create the source structures in the usual way. Then assign the subordinate source structure to the target structure. Thus, the fields of both source structures will be available for the fields of the target structure.
4.5 Maintain Field Mapping and Conversion Rules

In this step, you assign source fields to target fields and define how the field contents will be converted.

All fields of all target structures, which you selected in the previous step, will be displayed. For each target field the following information is displayed:

- Field description
- Assigned source fields (if any)
- Rule type (fixed value, translation etc.)
- Coding.

Note: Some fields are preset by the system. These fields are called „technical fields“ are marked with „Default setting“. The coding for these fields is not displayed when first entering the fieldmapping; it can be displayed via the display variant (see 4.5.1). Changing the default setting may seriously affect the flow of the data conversion. If you erroneously changed the default setting, you can restore it by choosing Extras → Restore default.
Field Mapping: Tree of Target Fields for the Target Structures Selected

The following functions are available:

**Field documentation**: Displays a short documentation for the target field the cursor is positioned on. The documentation may branch off to further information.

**Possible values**: Displays a selection list of all values possible for this target field.

**Longtext / Documentation**: Maintenance of the documentation for a field etc.

**Assign a source field**: To assign a source field, position the cursor on a target field in the tree structure and select **Assign source field**. This displays a list of all available source fields for selection. You can assign the fields by double-clicking on them.

**Note**: If you choose **Extras → Auto-Fieldmapping**, LSMW will give suggestions for assigning source fields to target fields.

**Remove the assignment of a source field**: To remove a source field assigned before, position the cursor on a target field in the tree structure and select **Remove source field**. If one source field has been assigned only, this field is removed. If several source fields have been assigned, a list of all source fields assigned is displayed for selection. The corresponding source field can then be selected by double-clicking on it.

After assigning the source fields, you define the **conversion rules**. The default rule is "Move". However, you can select various standard techniques via pushbutton.
Assign rules:

Initial: This deletes the coding assigned to the target field. In addition, source fields assigned to the target fields are removed as well. Depending on the object type, the target field is assigned the following value:
- For standard batch input/standard direct input: *Nodata* characters (determined e.g. in session header BGR00, BI000)
- For batch input recording: '/' as nodata character
- For BAPIs, IDocs: Clear field (i.e.: character field → blank; numeric field → '00...0')

Move: The data is transferred using ABAP command "Move". For source fields that are not of type 'C' or 'N', this means:

<table>
<thead>
<tr>
<th>Packed field</th>
<th>Unpack to target field</th>
<th>WRITE...TO...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date field</td>
<td>Popup to select</td>
<td>e.g. 01.10.1998</td>
</tr>
<tr>
<td></td>
<td>- internal format</td>
<td>YYYYMMDD</td>
</tr>
<tr>
<td></td>
<td>- user format</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ...</td>
<td></td>
</tr>
<tr>
<td>Amount field</td>
<td>Batch input/direct input: The amount value is edited according to the format settings in the user master. BAPIs, IDocs: The amount value keeps the internal calculation format.</td>
<td></td>
</tr>
</tbody>
</table>
**Constant**: The target field is assigned a fixed value.

**Fixed value (reusable)**: A "fixed value object" (variable) named FV_<fixedvalue> is assigned to the target field. This fixed value object is filled with an actual value in step "Maintain fixed values, translations and user-written routines".

**Translation (reusable)**: The target field is assigned coding carrying out field contents conversion using a translation table. The values of this translation table can be entered in step "Maintain fixed values, translations and user-written routines" see 4.6.

**User-written routine (reusable)**: The system creates the frame of a form routine (ABAP subroutine) with name prefix "ur_". This routine can be reused, i.e. it can also be used in other objects of the project.

With all kinds of reusable rules, the LSM Workbench proposes one to three possible names. One name is recommended by the system. SAP recommends you to use the proposed name. For details regarding naming conventions, see 4.5.4.

When creating user written routines please keep in mind that:
- the correct amount of source fields has been linked (regarding the amount of input parameters)
- the source fields are related in correct sequence (i.e. the sequence of the parameters).

**Prefix**: Specify any prefix to precede the contents of the source field.

**Suffix**: Specify any suffix follow the contents of the source field.

**Concatenation**: You can concatenate two or more source fields.

**Transfer left-justified**: Transfers the contents of the source field in left-justified form.

**ABAP coding**: Double-clicking on a target field branches off to the ABAP editor. There you can edit generated ABAP coding or write and save your own coding. A large part of the usual standard SAP editor functions, such as Check (syntax check), Pretty Printer, etc., are available there.

Under Insert you can add the following to your coding:

- **source fields**: all source fields available are displayed for selection
- **global variable**: see 5.7
- **global functions**: see 4.5.3

**XFIELD**: This is a special function for processing of IDocs. In some cases an ‘X-structure’ exists in addition to the data transfer structure (where the values for the import can be found); the fields of this ‘X-structure’ have to be filled with ‘X’ or blank to decide if the corresponding field in the data transfer structure should be transfered or not.

The following coding is generated automatically:

If not <field in the data transfer structure> is initial.

\[
\text{<field in } X\text{-structure} = 'X'.
\]

else.

\[
\text{<field in } X\text{-structure} = ' '.
\]

Endif.

![Note: Via Extras -> fill X-structures the coding for whole structures can be added](image)

### 4.5.1 For the Advanced User: Display Variant, Processing Times

**Define display variant**: In work step "Maintain field mapping and conversion rules", select '*' display variant'. This displays popup Define display variant. This function is useful mainly to advanced users who want to modify their field mapping.
You can specify the information to be displayed.

Global data definitions: Displays label __GLOBAL_DATA for global data definitions and declarations. There, you can define a variable, structures, tables, etc., to be used in the field mapping of your own coding.

Processing times: Here you can insert your own coding at specific processing times. The following processing times are available:
### Processing time

<table>
<thead>
<tr>
<th>Processing time</th>
<th>Meaning</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BEGIN_OF_PROCESSING</strong></td>
<td>Before the beginning of data processing</td>
<td>(blank)</td>
</tr>
<tr>
<td><strong>BEGIN_OF_TRANSACTION</strong></td>
<td>Before the beginning of transaction data processing</td>
<td>(blank)</td>
</tr>
</tbody>
</table>
| __BEGIN_OF_RECORD__ | Before applying the conversion rules for a source structure | Initialize the structure `<segment>` (Name of target structure)  
Batch Input, Direct Input: `<segment> = init_<segment>`.  
BAPI, IDoc: `g_edidd_segnam = '....'`.  
`g_edidd_segnum = '.....'`.  
`g_edidd_psgnum = '.......'`.  
`g_edidd_hlevel = '..'`.  
Clear `<segment>`. |
| __END_OF_RECORD__ | After applying the conversion rules for a source structure | Transfer_record. |
| __END_OF_TRANSACTION__ | After finishing transaction processing | Transfer_transaction. |
| __END_OF_PROCESSING__ | After finishing data processing | (blank) |

**Form routines:** Displays label __FORM_ROUTINES__ for form routines (ABAP subroutines). There, you can define ABAP subroutines to be used in your own coding for field mapping.

**Technical fields:** Displays the so-called technical fields. These are target fields for which LSMW proposes a conversion rule (e.g. constant). As a rule, modifications need not be made.

**Initial fields:** Displays initial fields.

**Coding:** Displays the stored coding.

**Note:** Under menu item Extras → Source fields not assigned you can display the source fields not yet assigned, i.e. you can see whether there is data which has not yet been adequately dealt with.

### 4.5.2 For the Advanced User: Global Variables

The LSM Workbench internally uses a number of global variables.

1. From the list of work steps, select Field mapping and conversion rule.
2. Branch off to the coding by double-clicking on a target field
3. Select Insert → Global variable.

This variable can be used in your ABAP coding.
### Global variable

<table>
<thead>
<tr>
<th>Global variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_project</td>
<td>Current project</td>
</tr>
<tr>
<td>g_subproj</td>
<td>Current subproject</td>
</tr>
<tr>
<td>g_object</td>
<td>Current object</td>
</tr>
<tr>
<td>g_record</td>
<td>Current target structure</td>
</tr>
<tr>
<td>g_cnt_records_read</td>
<td>Number of records read</td>
</tr>
<tr>
<td>g_cnt_records_skipped</td>
<td>Number of records skipped</td>
</tr>
<tr>
<td>g_cnt_records_transferred</td>
<td>Number of records transferred to a file</td>
</tr>
<tr>
<td>g_cnt_transactions_read</td>
<td>Number of transactions read</td>
</tr>
<tr>
<td>g_cnt_transactions_skipped</td>
<td>Number of transactions skipped</td>
</tr>
<tr>
<td>g_cnt_transactions_transferred</td>
<td>Number of transactions transferred to a file</td>
</tr>
<tr>
<td>g_cnt_transactions_group</td>
<td>Number of transactions in the current batch input session</td>
</tr>
<tr>
<td>g_userid</td>
<td>User ID</td>
</tr>
<tr>
<td>g_groupname</td>
<td>Name of the batch input session</td>
</tr>
<tr>
<td>g_groupnr</td>
<td>Current number of the current batch input session</td>
</tr>
</tbody>
</table>

### 4.5.3 For the Advanced User: Global Functions

The LSM Workbench provides a series of functions that can be used in any position of the ABAP coding.

![💡 Tip]

Note: These functions allow to partially considerably influence the flow of the data conversion program. Please do apply these functions with care.

1. From the list of work steps, select *Field mapping and conversion rule*.
2. Branch off to the coding by double-clicking on a target field
3. Select *Insert → Global functions*.

The following functions are available:

<table>
<thead>
<tr>
<th>Global function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>transfer_record</code></td>
<td>Transfers the current record (i.e. for the current target structure) to the output buffer.</td>
</tr>
<tr>
<td><code>transfer_this_record '...'</code></td>
<td>Transfers a record of another target structure to the output buffer. The name of the target structure has to be specified as argument in single quotes.</td>
</tr>
<tr>
<td><code>at_first_transfer_record</code></td>
<td>Transfers the current record to the output buffer, if it is the first transaction.</td>
</tr>
<tr>
<td><code>on_change_transfer_record</code></td>
<td>Transfers the current record to the output buffer, if it has changed compared to the last record.</td>
</tr>
<tr>
<td><code>transfer_transaction</code></td>
<td>Writes the current transaction to an output file. All records of</td>
</tr>
</tbody>
</table>
the output buffer are transferred to the output file.

skip_record.
The current record is not transferred to the output buffer.

skip_transaction.
The current transaction is not written to the output file.

### 4.5.4 For the Advanced User: Reusable Rules — Naming Conventions

Reusable rules are rules that are available across the project. They can be used in all objects of a project. Reusable rules are: fixed values, translations, and user-written routines.

If you assign a reusable rule to a target field, the system proposes one to three different names. To understand the naming conventions, we should look at the definition of data objects in the SAP system.

Data object definition in the SAP system is performed on three levels:

- **Domain**: On the "lowest" level, technical attributes are defined, e.g. field type, field length, value table or fixed values.
- **Data element**: On the "second" level, "semantic" characteristics are defined on the basis of a domain and its characteristics, e.g. language-dependent texts, documentation.
- **Field**: On top level, attributes of the field in the context of a structure or table are defined on the basis of a data element, e.g. foreign key relations, search helps.

This means in particular: For a domain, there normally are several data elements which refer to the domain.

(A count in the R/3 system, Release 4.5A produces the following figures: Domains: about 22,000, data elements: about 117,000, fields: about 1,028,000)

SAP recommends to accept the names defaulted by the system as a rule. An exception is given, if the domain is very general such as "CHAR1" (about 5,200 data elements) or "XFELD" (about 13,500 data elements. If you used the name of the domain in this case, the reusable rule might not be usable for another field, since this field may have a completely different meaning.

This naming procedure keeps the number of conversion rules small and maintains the consistency in data conversion.

**Example:**

<table>
<thead>
<tr>
<th>No.</th>
<th>Field</th>
<th>Data element</th>
<th>Domain</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BUKRS</td>
<td>BUKRS</td>
<td>BUKRS</td>
<td>Company code</td>
</tr>
<tr>
<td>2</td>
<td>CO_CODE</td>
<td>CO_CODE</td>
<td>BUKRS</td>
<td>Company code</td>
</tr>
</tbody>
</table>

Both fields are named "Company code". The field names are different, the domain is the same. Thus both fields should be filled with the same fixed value or the same translation or user-written routine.
4.6 Maintain Fixed Values, Translations and User-written Routines

In this step you can process the reusable rules of a project:

**Process Reusable Rules**

**Fixed value**: Here you can specify length, type, flag for lowercase/uppercase and value in addition to the description.
**Translation:** Here you can enter information on the source field and the target field:

![Translation interface screenshot](image)

*Change translation / Source field, target fields*

If you are creating a new translation you have to save data before you can change to **Control information**.
Control information: Here you can define the translation type. You can specify which of the two translation tables will be searched for a value first and which alternative will be selected, if no suitable entry is found:

1:1 translation values: Here you specify the value table to be used during translation. You may also upload the values from a PC file (text separated by tabs). In addition, F4 help is available in column “New value”.

⚠️ Important
During translation, only values for which the OK flag was set are included.

Interval translation values: Here you specify the value table to be used during translation by intervals. You may also upload the values from a PC file (text separated by tabs). In addition, F4 help is available in column “New value”.
Important
During translation, only values for which the OK flag was set are included.

4.7 Specify Files

In this step you describe all files to be used in the following steps:

- Your legacy data on the PC and/or SAP server
- The file for the read data
- The file for the converted data
Specify Files

If your legacy data is on the PC:

1. In change mode, position the cursor on the line "Legacy data — on PC (frontend)".
2. Select Add entry.
   A popup is displayed.
3. Specify file path (F4 help), file name and description and other properties.
If your legacy data is on the SAP server:

1. In change mode, position the cursor on the line "Legacy data on SAP server (application server)".
2. Select Add entry. A popup is displayed.
3. Specify file path, file name and description.
4. Under "Codepage ID", specify the indicator of the legacy system's character set.
5. Determine the technical record description and the separators.

Note: Please note that the SAP system uses user ID <sid>adm with regard to the operating system. Therefore, make sure that you have read/write authorization for the selected directory.
Please consider the following notes:

- If a file contains data for several source structures, the field sequence has to correspond to the source structure definition.

- If a file contains data for a single source structure, either the field sequence has to correspond to the source structure definition or field names have to be specified at the beginning of the file which can be used for assigning the columns to the fields.

- If a file contains end-of-line indicators (text file), packed fields are not allowed.

- If a file contains separators, packed fields are not allowed.

- PC files and server files may be mixed at will.

- In the following step, a file containing data for several source structures can be assigned to several source structures.

- In the following step, a file containing data for a single source structure can be assigned to one single source structure only.

- If several files are used in an object, the corresponding source structures have to contain fields of the same name. In our example, this is field CUSTOMER_NUMBER:
File of read data:

Here, the file name is entered. We recommend you to use file extension ".lsmw.read" to differentiate the read data from the converted data.

File of converted data:

Specify the file name. We recommend you to use file extension ".lsmw.conv". Fields "Logical path" and "Logical file name" should be filled only if this is required for the subsequently called batch input or direct input program (fields only are shown in this case) For both fields, F4 help is available.
4.8 Use Wildcards in File Names

Example for the usage of wildcards in file names: Let's assume that the legacy data is stored in the following four files:

- **File 1**: D:\Mig\Purchase Orders\PO Header 1.txt
- **File 2**: D:\Mig\Purchase Orders\PO Position 1.txt
- **File 3**: D:\Mig\Purchase Orders\PO Header 2.txt
- **File 4**: D:\Mig\Purchase Orders\PO Position 2.txt

Two files each (*.1.txt and *.2.txt) form a "set"; i.e. file 2 contains the position data for the header records in file 1, file 4 contains the position data for the header records in file 3.

When reading the data, files 1 and 2 shall be processed before files 3 and 4.

This is achieved by means of the following settings:
Specify Files: Using Wildcards

**Note:** You can also use a wildcard in the names of the files of read data and converted data.
4.9 Assign Files

In this step, you assign defined files to the source structures:

Note: If you change file names or properties subsequently, the file assignment is kept.

4.10 Read Data

Proceeding:

- If you want to process all data belonging to an object, click on Execute. The process is started.
- If you want to migrate a part of the data only, you can limit the number of data to be migrated in field "General selection parameters". Make your selection in field "Transaction number" from "... to ...". Multiple selection is possible.

If you marked one or several source fields as selection parameters when defining the source fields, these fields are also offered as selection parameters.

In addition, two check boxes are offered:

- Amount field: Amount fields are converted into calculation format (with decimal point).
- Date field: Date fields are converted into internal format (YYYYMMDD).

If you use a wildcard in the file names for the input files, and at least one value has been defined for the wildcard, a selection parameter for the wildcard is offered as well. If you do not make any entry here, all wildcard values defined are processed.
Data Read Program: With User-defined Selection Parameter

Note: First, the system checks whether the data read program is still up-to-date. If this is not the case, it is regenerated automatically.

4.10.1 Display Read Data

In this step, you can display all or a part of the read data in table form. Clicking on a line displays all information for this line in a clear way. The same happens when you click on Field contents.

Change display allows to select either a one-line or multi-line view. Display color palette displays the colors for the individual hierarchy levels.

4.11 Convert Data

4.11.1 General Remarks

With regard to operation, this work step essentially corresponds to work step "Read Data" (see 4.8).

If you do not make any data selection, confirm the process by clicking on Execute. Otherwise, make your selection in field "Transaction number" from "...to...". Here, multiple selection of transaction numbers is possible as well.

If you marked one or several source fields as selection parameters when defining the source fields, these fields are also offered as selection parameters.

If you use a wildcard in the file names for the input files, and at least one value has been defined for the wildcard, a selection parameter for the wildcard is offered as well. If you do not make any entry here, all wildcard values defined are processed.
Data Conversion Program: With User-defined Selection Parameter

**Note:** First, the system checks whether the data conversion program is still up-to-date. If this is not the case, it is regenerated automatically.

### 4.11.2 Additional Function for BAPI/IDoc

If the LSMW object is based on a BAPI or an IDoc, further selection parameters are displayed on the data conversion program selection screen:

**Convert Data: Further Selection Parameters for BAPI/IDocs**

If you select *Create file*, a file is created during data conversion.

If you select "Create IDocs directly", IDocs are collected during data conversion and submitted for IDoc creation in packages. The package size can be determined using parameter "Number of IDocs per package". The default value is 50.
4.12 Display Converted Data

See section 4.10.1.

4.13 Import Data

The steps displayed by the program depend on the selected object type:

- Standard batch input or recording:
  - Generate batch input session
  - Run batch input session
- Standard direct input:
  - Start direct input session
- BAPI or IDoc:
  - Start IDoc creation
  - Start IDoc processing
  - Create IDoc overview
  - Start IDoc postprocessing

5.17.1. Import Data with Batch Input

4.13.1.1 Generate Batch Input Session

In this step, the standard batch input program belonging to the object is directly called. The name of the file with the converted data is already proposed.

The batch input sessions to be generated are named after the LSMW object.

4.13.1.2 Run Batch Input Session

The program goes to SAP standard transaction SM35. However, only the batch input sessions for the selected object are displayed.

Note: If you used the name of the object in other projects or subprojects as well, batch input sessions from these objects may also be displayed.

4.13.2 Import Data with Direct Input

4.13.2.1 Start Direct Input Session

Depending on the object type, either the standard direct input program belonging to the object is called or you can select a direct input program or a direct input transaction.
4.13.3 Import Data with BAPI or IDoc Technique

Data stored in a file by means of the IDoc technique is generally imported in two steps. You can call these steps in LSM Workbench:

- **Start IDoc creation.** First, the file of the converted data is read. The "information packages" contained are stored in the SAP database in IDoc format. It is, however, not stored in the database of the corresponding application. The system assigns a number to every IDoc. Then the file of the converted data is deleted.

- **Start IDoc processing.** The IDocs created in the first step are submitted to the corresponding application program. This application program checks the data and posts it in the application's database, if applicable.

**Note:** Step "Start IDoc creation" is not performed, if you selected option "Create IDocs directly" during data conversion.

Whether the second step is automatically initiated depends on the settings of the ALE-EDI customizing.

One essential setting is made in the so-called partner agreement (for a partner and a message type, see section 4.2). This agreement specifies whether the IDocs are to be processed immediately or by means of a background program.

**Note #1:** Partner agreements automatically created by the LSM Workbench are set as follows: "Initiation by background program". (You can manually change this setting at any time.)

**Note #2:** During the processing of inbound IDocs, so-called work items are created in the standard program. This are elements of the SAP workflow that are usually not required during data migration. For information on how — and with which consequences — the creation of work items can be suppressed see Note no. 149368.

**Note #3:** CD-ROM "Interface Adviser" provided by SAP contains useful information that helps to increase performance in connection with IDoc processing. Follow the path ➔ Technology ➔ Interfaces ➔ Background processing ➔ Import ➔ ALE/IDoc ➔ Performance.

You can do the following in addition to these two processing steps:

**Create IDoc overview.** This displays a status overview which allows to display individual IDocs with the "drill-down" technique.
5 Recordings

Perform a transaction „trial run“;

⚠️ Caution This is no simulation mode! Your input is posted in the system!

Postprocess recording: Assign field names, field texts and default values
Save recording: This generates the above structure in the Data Repository.

⚠️ Caution In Attributes for an object you can assign any number of recordings to an object. This way you can run various transactions in succession for one data record.

5.1 Detailed Description of the Process

In the initial screen you select function Recordings under Goto.

![Recordings of project 'PROJECT00': Overview]

Note: Recordings are assigned to exactly one project.

Select Recordings → Create recording. Fill the displayed fields.
Create Recording

After pressing *Continue* you can start to record the transaction whose transaction code you have to enter first.

**Note**: If you do not know the transaction code of the transaction you selected: Select *System → Create session*. This displays the initial screen of the SAP system. Then select the relevant application component. This displays the relevant dialog screen. Select the transaction you want to record and then *System → Status*. The repository data includes the transaction code.

Now you can execute the selected transaction. Here you should input values in all the fields you intend to fill with the values from your legacy data later.

After the recording has finished, you can process it. You can delete or add fields.
**Process Recording**

You can assign field names freely. During the generation of the batch input session, the contents of these fields are assigned to the target fields displayed in the left column.

The following functions are available:

- **Default**: Assigns the field name of the relevant target field and its field description.
- **Reset**: Deletes field names and field descriptions.
- **Double-click**: Edits fields names, field descriptions and default values.

⚠️ **Important**

You may use field names repeatedly. However, in field mapping a field name can only be used once.

For all fields in which you did not specify a field name the specified default value is used for the batch input session generation. Thus these default values can be considered as constants. This is useful in particular with check boxes (e.g. MM01, view selection).

After you saved, the status line displays the following message: "Data saved successfully". The recording is now available among the attributes for the object.
6 Transport LSMW Projects

The LSM Workbench provides data transport for a project via both the SAP transport system and down-/upload. (Excluded are the presettings for IDoc inbound processing. These presettings should be manually created in every SAP system and every client.)

6.1 Generate Change Request

Choosing this function creates an SAP change request containing all information about an LSMW project. This SAP change request can be exported / imported with the usual means of SAP correction and transporting. You can find this function in the initial screen under Extras -> Create change request.

When transporting LSMW data this way, you can trace the transports any time in SAP correction and transporting.

Note 1: When importing such a request, the complete project is deleted from the target system first. It is then created again.

Note 2: When exporting the transport request, all changes to the selected project made until the time of export are entered (not only until the time of creation of the transport request.)

6.2 Export Project

In the initial screen, select Extras -> Export project. This first displays the structure tree of the selected project. Via Select / Deselect you can select whether the entire project or parts of the project are exported. Then select Export. The program then creates an ASCII file.
6.3 Import Project

The exported mapping and rules can be imported into another SAP system.

On the selection screen, select Extras -> Import. The program then prompts you to enter the name of the PC file. The file is imported and the contents are analyzed. After the analysis, a list of the subprojects and objects found is displayed.

You can now mark the objects to be imported. Project data existing already are check-marked. They are overwritten by the import.

You can prevent a project already existing in the target system from being overwritten by using function "Import under different name".

Note: The selected elements are imported together with their documentation.
7 Periodic Data Transfer

7.1 Only LSM

To a limited extent, the LSM Workbench also supports periodic data transfer. Preconditions are:

- The LSMW object has been created and tested completely.
- The "source application" periodically makes available one or several files on the SAP application server.
- The LSMW object does not access files on the frontend. (Files on the frontend cannot be read in batch mode.)

If all these conditions are met, you can set select button "Periodic" in step "Maintain object attributes". Then, step "Control program for periodic data transfer" is displayed in the overview of work steps. This program carries out the following steps in sequence:

- Read data
- Convert data
- Import data

This program (name: /SAPDMC/SAP_LSMW_INTERFACE) can be used according to your requirements.

**Note 1**: Specification of a flag file is optional.

**Note 2**: A flag file serves for creating a "handshake" with the application providing the input file(s):

- The control program for periodic data transfer is only executed if the specified flag file exists.
- After finishing data transfer, the control program for periodic data transfer deletes the flag file.
- The "providing" application should behave in a complementary way: Before new files are created, a check is carried out as to whether the flag file exists. If this is the case, the program stops. Otherwise, the files are generated, and the flag file is created.

**Note 4**: You can specify variants for the read program, the conversion program and (in case Batch/Direct Input) the Batch or Direct Input program. These variants have to be defined before.
Frame program for periodic data transfer

**Project, subproject, object**
- Project: SAP_DEMO
- Subproject: ACCOUNTING
- Object: CUSTOMERS

**General parameters**
- Flag file (path and name): 
- Values for wildcard (*): to 

**Handling of the input files (legacy data)**
- Leave after processing: 
- Delete after processing: 
- Rename after processing: 

**Handling of the files with read and converted data**
- Leave after processing: 
- Delete after processing: 
- Rename after processing: 

**Read data**
- Amount fields -> 1234 56
- Date values -> YYYYMMDD

**Convert data**
- Create file: 
- Pass IDocs directly: 
- Number of IDocs per package: 
- Variant (conversion program): 

**Import data**
- Batch input: Submit session
- BAPI/IDoc: Process IDocs
**Note 3:** Some of the standard batch input and direct input programs use additional parameters. Some of these parameters are also used in other programs. For information about which parameters are used in which program, please refer to the coding of program `/SAPDMC/SAP_LSMW_INTERFACE`.

<table>
<thead>
<tr>
<th>Program</th>
<th>Test run without update</th>
<th>Create batch input session</th>
<th>BI, DI, Call Transaction, Test</th>
<th>Lock mode</th>
<th>Action</th>
<th>User group</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAALTD01</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAALTD11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCCLBI01</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCCLBI02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCCLBI03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCCTBI01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCSBI010</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCSBI020</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCSBI030</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCSBI040</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RCVBI010</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RFBIBL00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RHALTD00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RLBEST00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RLPLAT00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RMDATIND</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RPUSTD00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
7.2 Periodic interfaces with DX-Workbench and LSMW

7.2.1 How does the process work?

1. The legacy system provides a file with data to be imported (file1)
2. Step ‘Mapping’ is started
   a. For this step LSMW is used
   b. In LSMW the file name to be read is defined with an asterix / wildcard (file*), in addition the value for the asterix is stored as ‘wildcardvalue’ – for the first transfer the wildcardvalue is set to ‘1’ manually
   c. LSMW reads file1 and does mapping / conversion for the file; the converted data is stored in a file with a fixed name (for example ‘file.lsmw.conv’)
3. Step ‘Loading / import’ is started
   a. The file with the converted data (file.lsmw.conv) is used for importing the data to the database tables of the SAP System
4. Step ‘Wildcard / copy files’ is started
   a. For this step a function module called ‘/SAPDmc/SET_WILDCARDVALUE’ is used
   b. This function module increases the wildcardvalue in LSM by 1 (in this example, the wildcardvalue will be ‘2’ after this )
   c. In addition the ‘old’ source file is renamed; ‘file1’ becomes ‘file1_old’; renaming the file guarantees that the file will not be processed twice
5. The legacy system provides the next file with data to be imported (file2)
6. …
7.2.2 Set up DX Workbench

7.2.2.1 Create a project in DX Workbench
Name and description of the project have to be entered

7.2.2.2 Create a subproject in DX Workbench
Please enter the name and description for the subproject together with the object type (business object) the interface will be used for
7.2.2.3 Create a run definition in DX Workbench

Please enter name and description of the run definition.

7.2.2.4 Create tasks in DX Workbench

Enclosed you will find the three main tasks – in your system you might add extra tasks for programs which have to run additionally.

7.2.2.4.1 Task “mapping”

The first task includes the mapping via LSMW – please specify the LSM project, LSM subproject and LSM object to be used.

First step:
Second step:

7.2.2.4.2 Task “loading / import”

The second task will do the import of the converted data to the database of the application – please select the import interface you want to use (the screen shots show an example, screens may differ according to the object type and program type selected).

First step:
7.2.2.4.3 Task “wildcard / copy files”

This task increases the wildcard value by 1 and renames the source file (“filex” ➔ “filex_old”)

Register function module

The task is performed by function module “SAPDMC/SET_WILDCARDVALUE”; this function module has to be registered for the object type you want to use it for.

Use DX-workbench ‘ Goto -> DX Program Library ‘ and register the function module for the business object you want to use it for.
Legacy System Migration Workbench

**Register Function Module**

- **Object type**: STD_TEXT
- **Function module**: `/sap/mc/set_wildcardvalue`

**Data Transfer - Program Library**

- **Object Name**: StandardText
- **Object type**: STD_TEXT
- **ObjDescr**: SAP script standard text
- **Task type**: Various
- **Program type**: Various
- **Function module**: `/sap/mc/set_wildcardvalue`
- **Documentation**
Create the task

- Object type: STD_TEXT
- Object description: SAP_except_standard_text
- Function module: /SAPOMC/SET_WILDCARDVALUE
7.2.3 Set up LSMW

7.2.3.1 Enter the file names
The file names for the source files have to be defined in step ‘Specify files’. The files have to be on the application server (data from the PC / presentation server can not be read in a background job).

7.2.3.2 Set the first wildcard value
Before starting the periodic interface the wildcard value has to be set to a start value.
7.2.3.3 Set flag ‘periodic’
Flag ‘periodic’ should be set in the object attributes.

7.2.4 Restrictions
- Wildcard value has to be set to a starting value (for example ‘1’ ) at the beginning
- Only one wildcard value allowed
- Wildcard value has to be numeric ( 1 to 999.999.999.999.999.999.999.999.999; 30 chars available)
- Generic filename with ‘*’ for the source data
- Source data on application server
- No wildcard in the file for the converted data
- Flag ‘periodic’ has to be set in the object attributes of the LSM object
• The import interface has to return a status (only after an successful import the wildcardvalue should be increased); batch input and direct input can not be used in the process
• Only one mapping task in the DX project
• LSMW Object should be used only one in the DX workbench

7.2.5 Schedule run

The jobs can be scheduled via button ‘schedule run’ in the DX-workbench
7.2.6 Logs

7.2.7 Problem constellations and how they are handled

7.2.7.1 A job (run) terminates with error

In the joblog only a information message can be found:
The next job is canceled:

What has to be done?
1. Correct the problem
2. Finish the run manually in DX Workbench

7.2.7.2 No task for mapping in DX-Workbench or more than one task for mapping
During task 'wildcard / copy files' an error message is issued:

"Task with task type 'MAP'(LSMW) does not exist or exists more than once"
(/SAPDMC/LSMW531)

What has to be done?
1. Check the project in DX Workbench
   a. Is there a task with task type 'MAP'? 
   b. Is there only one task with task type 'MAP'? 
   c. If there are several tasks with task type 'MAP': Which conversions have been done and which file has been used for the import?
2. Correct the project in DX Workbench
3. Set up the interface again (start value for wildcard, provide files etc)

7.2.7.3 No LSM Data in the mapping task
When starting the run an error message is issued:

"Attributes for task mapping do not exist."(S_DX_BAPI074)

7.2.7.4 Leading zeros in the wildcard value
The number of places is not changed; 0001 is increased to 0002, 0009 is increased to 0010

7.2.7.5 No input files entered in LSM
When starting the run or trying to schedule the run an error message is issued:
“LSM object xxx in project xxx is incomplete” (S_DX_BAPI700)

7.2.7.6 More than one wildcard value in LSM
If flag ‘periodic’ is set in the object attributes of LSM a check is done at the beginning of the mapping step and an error message is issued if there is more than one wildcard value:

“Wildcard value for & - & - & not unique.” (/SAPDMC/LSMW526)

7.2.7.7 Wildcard value not numeric
An error message is issued:

“Wildcard value & in object & - & - & can not be increased” (/SAPDMC/LSMW527).
The import with the ‘invalid’ wildcard is done → set the wildcard value to a valid start value

7.2.7.8 More than one source file
The wildcard ‘*’ is replaced by the wildcard value in all files

7.2.7.9 Copy / rename of files fails
The task has to be redone manually via the DX Workbench; the wildcard value will not be increased

7.2.7.10 How to get the current wildcard value via RFC
A function module is not available at the moment. The table to be read is /SAPDMC/LSOFIW.
Please note that in this table the wildcard value for the next conversion / import can be found; there is no history for wildcard values which have already been used for file creation in the source systems.
This means: to get the next wildcard value to be used for file creation, you have to check the value in /SAPDMC/LSOFIW and the files already created. Please add 1 to the highest value.

7.2.7.11 Multiple source systems
If more than one source system wants to use the same importing logic please proceed as follows:
- create a run definition for each source system
- create an LSM object for each source system
- the mapping and conversion rules should be created as user routines which are used in all objects
8 Long Texts

To transfer long texts, there are two possibilities:

- Direct input program /SAPDMC/SAP_LSMW_IMPORT_TEXTS (object 0001, method 0001); this object is not available in the standard program. To make it available, run the following program:
  /SAPDMC/SAP_LSMW_SXDA_TEXTS

- Direct input program RSTXLITF (object 2000, method 0000); to be able to use this object, you have to download the transport from SAPNET (http://service.sap.com/LSMW) and import it into your system

8.1 Long Texts in the SAP System

Long texts (texts covering more than one line) are stored in a text pool in the SAP system. The key of a long text is composed of four parts:

<table>
<thead>
<tr>
<th>Key field</th>
<th>Meaning</th>
<th>Example</th>
<th>Length</th>
<th>Check table</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJECT</td>
<td>Application object</td>
<td>AUFK = Order texts</td>
<td>10</td>
<td>TTXOB, TTXOT</td>
</tr>
<tr>
<td>ID</td>
<td>Text ID</td>
<td>Object AUFK</td>
<td>4</td>
<td>TTXID, TTXIT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Id KOPF = Order header text</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Id POSN = Order item text</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Id RMEL = Order confirmation text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NAME</td>
<td>Actual text key</td>
<td>Order number</td>
<td>70</td>
<td>(none)</td>
</tr>
<tr>
<td>SPRAS</td>
<td>Language</td>
<td>Text language</td>
<td>1-2</td>
<td>T002</td>
</tr>
</tbody>
</table>
8.2 Determine Text Key Structure

There is no uniform rule for the structure of the actual text key NAME. To determine the values for OBJECT and ID for a specific text type and the structure of NAME, proceed as follows:

— Display a text of the required text type (e.g. order header text) and branch off to the editor.
— There you can display the required information via Goto → Header.

The following applies in the above example of a material sales text:

OBJECT = MVKE
ID = 0001
NAME
— Material number (18 characters) +
— Sales organization (4 characters) +
— Distribution channel (2 characters)
8.3 Develop Objects for Long Texts via Object 0001

The following target structures are available:

/SAPDMC/LTXTH: Long text header
- STYPE Record type (technical field, value = '1')
- OBJECT Application object
- NAME Text name
- ID Text ID
- SPRAS Language

/SAPDMC/LTXTL: Long text text line
- STYPE Record type (technical field, value = '2')
- TEXTFORMAT Format field (2 characters)
- TEXTLINE Application object

Field TEXTFORMAT contains text formatting information. To simply map the field 1:1, enter character '*'.

For the material sales text in the example, a migration object could look as follows:

![SAP Workbench interface showing source fields for text data conversion](image-url)

Long Texts: Source Fields
Long Text: Structural Relationships
Legacy System Migration Workbench

**Note:** Statement on `change_transfer_record`. has the effect that the text header is transferred only, if it has changed compared to the previous record (see 4.5.3).
8.4 Develop Objects for Long Texts via Object 2000

Please have a look at the documentation for program RSTXLITF first. There you will find very useful information concerning the file format the import program needs.

The following target structures are available (defined during the import of object 2000):

/SAPDMC/LSMW_TEXTHTEXT
/SAPDMC/LSMW_TEXTOBJEKT
/SAPDMC/LSMW_TEXTNAME
/SAPDMC/LSMW_TEXTID
/SAPDMC/LSMW_TEXTLANGUAGE
/SAPDMC/LSMW_TEXTFORM
/SAPDMC/LSMW_TEXTSTYLE
/SAPDMC/LSMW_TEXTFIRSTUSER
/SAPDMC/LSMW_TEXTFIRSTDATE
/SAPDMC/LSMW_TEXTFIRSTTIME
/SAPDMC/LSMW_TEXTLASTUSER
/SAPDMC/LSMW_TEXTLASTDATE
/SAPDMC/LSMW_TEXTLASTTIME
/SAPDMC/LSMW_TEXTTITLE
/SAPDMC/LSMW_TEXTTITLE1
/SAPDMC/LSMW_TEXTTITLE2
/SAPDMC/LSMW_TEXTMAIN
/SAPDMC/LSMW_TEXTLINE

Most of the fields for these structures are technical fields and are filled by default.

A migration object could look as follows:
8.5 Import Texts

Texts are imported into the SAP system by means of direct input. The relevant direct input program can be easily called from the LSM Workbench via Start Direct Input Session.

Important

After the import of long texts, sometimes these cannot be read within the corresponding application. Via function module 'READ_TEXT', the texts are found, thus, they are stored correctly in the database. Some applications have a field in the master data which shows whether a long text exists or not. This field is not filled by the direct input programs (since these programs apply to all applications, and at runtime it is not known which application a text belongs to.

There are 2 possible solutions:

1. The flag is supplied by a user-defined report after the import
2. In the field assignments / mapping an update is coded on the respective table; however, this that the flag is set already during the conversion  ➔ if the text is not imported later, the flag is set, however, no long text is available.
9 Tips and Tricks

9.1 Determine the Transaction Code at Runtime

Situation: You want to transfer data a part of which has already been created in the system. You want to decide at runtime whether the data is created or changed.

Example: Customer master

Solution: Insert under "Global Data":

```
TABLES: KNA1.
```

Add the following coding for field BKN00-TCODE:

```
Select count(*) from kna1 where kunnr = <alte_kundennummer>.
  if sy-dbcnt = 0.
    bkn00-tcode = 'XD01'.
  else.
    bkn00-tcode = 'XD02'.
  endif.
```

9.2 Skip a Record

Situation: You want to "skip" a record depending on a certain condition, i.e. this record shall not be converted and transferred to the output file

Solution:

```
if <condition>.
  skip_record.
endif.
```

9.3 Skip All Records of a Transaction

Situation: You want to "skip" all records of a transaction depending on a certain condition.

Solution:

```
if <condition>.
  skip_transaction.
endif.
```

9.4 Duplicate a Record

Situation: You want to create two (or more) target records from a source record.

Example: Your customer master of legacy files consists of one record containing among other things the fields "First name", "Name", "Phone number" for two contact persons. In the SAP system, a BKNVK record has to be filled for each contact person.

Solution: Your legacy structure is assumed to look as follows:

```
CUST Customer master
  ...
  VORNAME1  First name of first contact person
  NACHNAME1 Name of first contact person
  TELEFON1  Phone number of first contact person
  VORNAME2  First name of second contact person
  NACHNAME2 Name of second contact person
  TELEFON2  Phone number of second contact person
  ...
```
Create the following rules:

```plaintext
...  
BKNVK-NAME1  
←  CUST-NACHNAME1 (Move)
BKNVK-TELF1  
←  CUST-TELEFON1 (Move)
BKNVK-NAMEV  
←  CUST-VORNAME1 (Move)
...  

and add

__End_of_Record__

transfer_record.

...  
BKNVK-NAME1 = CUST-NACHNAME2.
BKNVK-TELF1 = CUST-TELEFON2.
BKNVK-NAMEV = CUST-VORNAME2.

transfer_record.
...  

at processing time. This creates two BKNVK records.

9.5 Error messages in the conversion log

How can user-defined error messages be added to the conversion log?

1. Use of WRITE command in the Coding
   a. Example: WRITE: 'Error during conversion of field xxx'

2. In the editor use 'Insert -> Message' to use a message already existing in the SAP system.
   a. Example (Coding after using the menu function and filling the fields):

   ```plaintext
   WA_ERRORTAB-ID = '/SAPDMC/LSMW'.
   WA_ERRORTAB-MSGNO = 012.
   WA_ERRORTAB-PAR1 = 'A'.
   WA_ERRORTAB-PAR2 = 'B'.
   WA_ERRORTAB-PAR3 = 'C'.
   WA_ERRORTAB-PAR4 = 'D'.
   INSERT WA_ERRORTAB INTO TABLE G_ERROR_TAB.
   ```

   The message will be added to the log.

9.6 Extra Handling for “POS-IDOCs”

What is a “POS-IDOC”? – These are IDocs where the control record (EDI_DC40) has to be filled with source data (example message type WPUWBW, where the store number is transferred via the control record). This means control record EDI_DC40 needs to be available as target structure in step “maintain structure relations”; in the fieldmapping rules and processing points have to be identical to the other target structures

How does the processing look like for “POS-IDOCs”? 

Step “maintain object attributes”

Please set flag “Enable structure relation for EDIDC40”
Step “maintain structure relations”

Please assign a source structure to target structure EDI_DC40:

Step “maintain fieldmapping and conversion rules”

→ EDI_DC40 is available as target structure inclusive processing points

In all other steps there are no changes.
10 Final Remarks

There only is to wish you success in your data migration project.

Yours sincerely

Your SAP LSMW team